CHAPTER 10

REPORTS

Maybe you can’t judge a book by its cover, but appearances do matter. Readers will reject even the most compelling information if they can’t easily understand and digest it. In Access, you use reports to create attractive hard copy (usually meaning paper printouts) that can be quickly grasped and absorbed.

Most of the design tools you use in a report you can also use in a form. As graphical media for conveying information, the two have much in common. But whereas reports are usually used to create hard copy, the function of a form is primarily to enter or edit data. In addition, forms tend to center on individual records, whereas reports usually have a wider focus that captures a broader picture.

A report has many advantages over a datasheet. You can include extra blank space for notes and comments. A thoughtful design will organize raw data in ways that will make it far more meaningful. With a report, you can display images such as photos, maps, and diagrams. Notably, report tools make it extremely easy to generate summary statistics such as totals and averages that are of key importance to information users.

Learning How to Create Reports

The Report Wizard reminds me of my mother’s old dishwasher. Overall, it was easy to use and the dishes got clean. But occasionally a washed glass had a bit of film on it.

The Report Wizard is similarly effective and inconsistent. Compared with most other Access objects, reports are difficult to create. Unless you’re simply displaying a few fields, building them from scratch is a headache. The gloriously efficient Report Wizard is thus a most welcome tool.

But even when the wizard is at its best, its reports are a little, well, scruffy. They require some tinkering—a wider text box here, a larger font there—to get them in shape.
The main problem with the Report Wizard is not these small imperfections, though. As with other wizards, it (mostly) gets the job done. But if you use it exclusively, you don’t learn any of the methods and techniques needed to create a report. That’s a huge drawback when, inevitably, you want to edit something in it. Take a look at a fairly simple report in Design view (see Figure 10.1). To the uninitiated, it almost screams “Don’t even think of changing anything.”

Figure 10.1 Almost any report in Design view looks complex if you don’t know its intricate workings.

So here’s the game plan for this chapter. First you’ll create a report from scratch. You’ll delve into its innards to understand how a report works. Along the way, you’ll learn or extend your knowledge of key report techniques such as grouping, concatenation, and calculated expressions.

Then you’ll create a similar report using the wizard. By that time, you’ll have a much better feel for what the Report Wizard is up to when it asks you all those questions. You’ll then compare the reports created under both methods. In the case study, you’ll learn a few more techniques and tools for creating better reports.

You might find the close detail of this chapter excruciating. But if you’ve tried to create or modify reports, you know how a single misplaced control can throw your entire report out of whack. Don’t let all the minutiae stand in the way of the important goal of getting a handle on the overall construction and design of the report.
The Asia Database

For a change of pace and to give you exposure to another database, in this chapter you’ll use the Asia database (AsiaChap10.mdb). The database includes “official” statistics on Asian nations, adapted from the renowned CIA World Factbook (in the public domain at www.cia.gov/cia/publications/factbook). As with all government stats, they have their limitations. Often they are reliable, but some should be taken with a grain (or megaton) of salt. By their very nature, certain statistics (such as land area) are much more accurate than others (such as GDP per capita).

Let’s take a quick look at this database. Copy AsiaChap10.mdb to a convenient folder on your hard drive. Open the database and choose Tools, Relationships to open the Relationships window (see Figure 10.2). The Countries table (which, per the Access naming convention we’ve been using, is titled tblCountries) contains some key data about each nation, including area, population, and fertility rate.

Figure 10.2 The Relationships window for the Asia database.

There are also two validation (or “lookup” tables), tblGovernment and tblHistory; these support data integrity, uniformity, and simplicity. Two foreign ID keys in the Countries table enable one-to-many relationships with the lookup tables.

The Government table assigns types (monarchy, republic, and so on) to the various forms of administration in place on the continent. As you can imagine, a single type encompasses a wide range of governmental forms...
and situations. But the types can serve as a crude measure of the sort of
government that was in place in the year 2002.

The History table has data about the major foreign powers that con-
trolled the country before their independence. Because I've assigned a sin-
gle type of historical rule to each country, the data is overly general and
simplistic. Still, it's fair to say that the Dutch were in Indonesia, the British
were in India, and the Japanese remained independent from foreign rule.

---

**TIP** To get a better feel for the database, open the tables and view them in both
Datasheet and Design view. If you need a refresher on relationships and lookup
tables, take a look at Chapter 4, “Establishing Relationships.”

---

**Begin the Report by Creating a Query**

Usually you'll want to create a report from a query that pulls together data
from two or more tables as your record source. You'll create a query that
combines key fields from tblCountries, such as area and population, with
fields from the other tables that will display the government type and his-
torical legacy.

1. If your Relationships window is still open, close it.
2. In the Database window, click Queries. Double-click Create
   Query in Design View.
3. In the Show Table dialog box, add tblGovernment, tblCountries,
   and tblHistory (in that order) to the query. Close the Show Table
dialog box.
4. If necessary, maximize the design window. From the Countries
   field list, double-click the Country, Area, and Population fields
to add them to the grid.
5. From the Government field list, add GovtType to the grid. From
   the History list, add HistRule (see Figure 10.3).
6. Click the View button at the far left of the toolbar to switch to Print
   Preview view and view your records.
7. Choose File, Save and save the query as qryAdministration.
8. Close the query.
NOTE The source of a report doesn’t have to be a query. For example, you can create an AutoReport, a simple columnar listing of all fields and field values in a table, by selecting the table in the Database window and choosing Insert, AutoReport. In that case, the source for the records is the table itself. But because the power of a relational database is manifest in bringing together data from different tables, queries are a much richer and more pertinent example.

**Beginning a Report in Design View**

Now you’ll use this query as the basis for a new report that you’ll design from scratch:

1. In the Database window, select *qryAdministration* and choose Insert-Report.
2. With Design View chosen, click OK.

The query field list should be in view; if not, choose View, Field List (or peek ahead to Figure 10.1 to locate the Field List button on the toolbar). If a property sheet is open, close it.
3. Choose View, Page Header/Footer to get rid of these two sections.
4. Choose File, Save. Save the report as rptAdministration.

**TIP** Architects have to worry that the buildings they design will look as good in concrete as they do on paper. Access users don’t have that problem. You can click the View button again and again to see what effects your work in Design view is having on your report. You can also print a page.

---

**Detail Section**

Reports consist of controls that provide the labels, field values, lines, page numbers, and more that make up the report. Where and how often those controls appear on the printed report is determined by the section in which the control appears.

Only the Detail section is currently in view. This section is the main body of the report and is usually used to display actual values. Theoretically, you don’t need a Detail section to have a report. But as a practical matter, nearly all reports have one.

1. Double-click the title bar in the field list to select all the fields.
2. Drag and drop them 1.5 inches from the left and two rows of dots from the top.
   There are two sets of boxes for each field. Text boxes are on the right; they contain the actual field names, and they’re the controls that display the fields’ values. The labels are on the left; they display the captions for each field, as determined by the Caption property in the underlying tables. Notice that the GovtType and HistRule fields use the captions Government Type and Historical Rule, respectively, which are easier for readers to understand.
3. Click View to see the report in Print Preview.
   When viewing the actual report, two views are available: Print Preview and Layout view. Print Preview gives you the entire report; Layout view shows you just a few sample pages. Long reports can require much formatting, so Layout view saves time if all you need is a quick look. This report is short, so you can use Print Preview.
A few things need fixing in the report (well, more than a few, but let's concentrate on essentials). The fields are a little close together. Some of the Country and Government Type values are truncated. Also, numbers are currently aligned right; they'd probably look better aligned left. And it would be nice if the Country field values were bold.

1. Click View to return to Design view.
2. All text boxes are currently selected (the selector handles are in view on all four sides of each). To increase spacing between fields, choose Format, Vertical Spacing, Increase. Do it again. Now you'll widen the text boxes.
3. With all text boxes currently selected, choose View, Properties. Note that the property sheet says Multiple Selection, which means that more than one element is selected. The settings you make in this property sheet will apply to all currently selected elements.
4. On the Format tab, edit the Width to 1.35", which will apply to all selected text boxes. Close the property sheet.
5. Click anywhere outside the text boxes to deselect them. To left-align the numbers in the report, click the Area text box, press Shift and continue to hold it down, and then click the Population text box. On the Formatting toolbar, click the Align Left button (if you can't find it, take a peek at Figure 10.5).
6. Click the Country text box and click Bold on the Formatting toolbar.
7. Click View to see your work.

Your records should look like those in Figure 10.4. If they don't, click View to switch to Design view and compare your work to the Detail section in Figure 10.5. (Ignore the Page Footer, which I discuss next.)
Figure 10.4 The Administration report.

TIP Reports have a lot of different elements; it’s easy to choose the wrong one. Keep an eye on the title of the property sheet to make sure you’re changing the height of, say, a text box, and not its label, its section, or some other control.

Page Header and Footer

As you saw previously, the Page Header and Footer on the View menu hides and unhides these two sections. The controls you create in the page header and footer print, respectively, at the top and bottom of every page.

If you want to use just the header or the footer, there’s an easy way to make the other exist in name only. You’ll be using only the Page Footer here, so you’ll show both sections and then hide the Page Header:
1. Click View to return to Design view.
2. Choose View, Page Header/Footer.
3. Right-click Page Header and choose Properties. On the Format tab, set Height at 0" and close the property sheet.

The Page Header is now simply a bar with no area. Now you’ll use the Page Footer to display page numbers, one of its more common uses:

5. In the Page Numbers dialog box, select Page N for the format and Bottom of Page for the position. Edit the alignment to Left. Show Number on First Page should be selected. Click OK.

These settings are purely for teaching purposes. You might want different choices for your own report.

6. Click View to see the report. Scroll down to the bottom of the page. The page number appears as Page 1.
7. Click the Next Page button. At the bottom of the page is Page 2.
8. Click View to return to Design view. Find the page number control in the Page Footer. As shown in Figure 10.5, there is an expression inside: = "Page " & [Page].

Figure 10.5 The expression in the Page Footer gives you page numbers on each page.
Using Concatenation

Chapter 7, “Find and Filter,” introduced expressions and how to construct them. In Chapter 9, “Queries, Part II,” you used the & operator in a parameter query but without explanation, which I promised to provide in this chapter. So here I review expressions and explain the & operator by answering this question: How does=”Page ” & [Page] give you page numbers on every page?

Deconstructing the Expression

Let’s look at each part of the expression:

■ You start with the = sign. In the text box of a report, you use this to tell Access to get ready for an expression.
■ Next is "Page ". When you viewed the page numbers in Print Preview (Page 1, Page 2, and so on), each began with Page. This is a text string that Access prints exactly as it’s written. It’s really just a label. When you create expressions, you put text strings in quotation marks, so it becomes "Page ". But you want to have a space after Page; otherwise, pages would read Page1, Page2, and so on. So the full text string is "Page ", which has a space after the e.
■ Now for [Page]. This denotes the Page property, which tells Access to print 1 on the first page and then add one to each succeeding page.

Overall, you have two parts to the expression: the text string Page with a space after it, and a property that returns a number on each page, starting with 1 and increasing by one on each succeeding page. How do you bring these two elements together to give you Page 1, Page 2, Page 3, and so on?

The answer is concatenation. The word is derived from the Latin concatenare, meaning “to link together.” Because linking has its own specific meanings in Access, it’s probably better to think of concatenation as a way to bind or tie together certain elements.

The symbol of concatenation is the ampersand (&). In the complete expression ="Page " & [Page], the & tells Access that, after it has printed Page and left a space, it should print the page number.
Bringing Fields Together with Concatenation

Perhaps the most important use of concatenation is tying fields together in a single control. I’ve emphasized that the way you store information has little to do with the way you ultimately want to use it. You therefore break down the data and store it in its smallest and purest form. This gives you maximum flexibility when you want to combine data in queries and reports.

People’s names, for example, are usually stored in FirstName and LastName fields (there are exceptions). That makes sense because you’ll often want to use either the first or last names separately (such as sorting people by family name).

But on numerous occasions you want first and last names to appear together in the normal way (as in Henrietta Maccabee or Jake Timberlane), as in an invoice. You could position the FirstName and LastName text boxes on the grid so that they are flush. But that’s a sloppy and inelegant solution because the spacing between first and last names will inevitably be irregular.

The answer is concatenation, which lets you tie field values together so you can’t tell that they are separate fields. Here is how to create the name in a report:

- Type = to signal that it’s an expression.
- Type [FirstName], the first name field.
- Type & to tie what comes before to what follows.
- Type " ". This is a single blank space, surrounded by quotation marks to indicate it’s a text string.
- Type & to tie what comes before to what follows.
- Type [LastName] for the last name field.

The complete expression is = [FirstName] & " " & [LastName].

Report Header and Footer

In certain respects, the Report Header/Footer is similar to the Page Header/Footer. Most notably, a single command—Report Header/Footer on the View menu—toggles between hiding and unhiding both header and footer. As with the Page Header/Footer, either section can easily be eliminated by adjusting its height to 0 inches.
Unlike a page footer or header, however, a report header or footer appears only once: at the beginning and end of the report, respectively. The report header can be used for a title, the publishing entity, the date, and (perhaps) an introduction. The footer that closes the report is primarily used for summary information, such as the total of all values of particular fields.

**Adding a Title to the Report Header**

A Report Header often creates a cover page—that is, a full, standalone page 1. The case example at the end of the chapter builds such a page. Right now, let’s just create a short title at the top of page 1.

1. In Design view of rptAdministration, choose View Report Header/Footer.
2. In the toolbox, click the Label button (refer ahead to Figure 10.7 for its location; if your toolbox isn’t visible, choose View, Toolbox). Drag the crosshairs pointer to the Report Header section and click anywhere inside it.
3. Type National Governments and click outside the box.
4. Click the label to select it and press F4 to open its property sheet.
5. On the Format tab, scroll down to Font Size and edit the setting to 16. Edit the Font Weight to Bold and Text Align to Center.
6. Move your mouse to the upper-right handle of the label and click when the pointer becomes a double-arrow (see Figure 10.6). The text of the label is in full view.

![Figure 10.6](image_url)

**Figure 10.6** When you click the double arrow, the control resizes so the label is in full view.

7. On the Format tab, edit the Width slightly to 2.5”. Edit Left to 2", Top to 0.5” and Height to 0.5” Your Report Header should look like Figure 10.7.
8. Close the property sheet.
9. Click View to see the report.

Printout Problems

It's little use designing great-looking reports if they don't print on paper correctly. Let me deal with two common problems.

How Do I Center a Title on the Page?

Create the title and make font selections first so you know how wide the label will be. In the example, the label is 2.5 inches wide. (I had you edit the width slightly so it was a round number and, hence, easier to work with.) I'll assume you're working with letter-size paper and Portrait orientation, so the width is 8.5 inches. (Portrait versus Landscape orientation is discussed briefly in the "Layout" subsection of the section "Creating a Report Using the Report Wizard," near the end of the chapter.)

The page is 8.5 inches wide and the label takes up 2.5 inches, so you have 6 inches (8.5 inches – 2.5 inches) of empty space. You want half of 6 inches to be on both the left and right of the label, which is 3 inches on each side.
Choose File, Page Setup. On the Margins tab, you can see that the default margins for Access are 1 inch on the left and 1 inch on the right. So the margin will take 1 inch of that 3 inches of empty space. Thus, the Left property for the label (where the label begins) should be 3 inches – 1 inch, or 2 inches.

**EVERY SECOND PAGE OUT OF MY PRINTER IS BLANK!**

The problem here is that your report or margins are too wide. To print your report correctly, the following equation must be true:

\[
\text{Report width} + \text{left margin} + \text{right margin} \leq \text{paper size}
\]

I've just covered margins and paper size. The report width is the actual width of the report, not the width of the printed text. For example, in Figure 10.7, look at the horizontal ruler and note that the report width is 5 inches, even though the right border of the rightmost control (the title) is at 4.5 inches. (The report width can also be found on its property sheet. Double-click the report selector—see Figure 10.7 for its location—and click the Format tab to view the Width property.)

Assume that the report width is 7 inches and margins are 1 inch on both sides. The equation becomes: 7 inches (report width) + 1 inch (left margin) + 1 inch (right margin) = 9 inches.

That's greater than the paper size of 8.5 inches, so you have a problem. Often the best solution is to reduce the width of the report. If the right border of the rightmost control is at 4.5 inches, the report width need not be 7 inches. If you made the report width 5 inches, your equation becomes a satisfactory 5 inches + 1 inch +1 inch \(\leq\) 8.5 inches. Similarly, you could make the margins slightly smaller.

---

**NOTE** You’ve been using property sheets to edit the various parts of a report. It’s often easier to use your mouse to move, resize, and format sections, controls, and other report elements. You’ll get some practice doing that in the following section.

---

**Adding Totals in the Report Footer**

Now let’s use the Report Footer. Suppose you’d like a grand total for the area of all Asian countries. Here’s how to create the control and calculated expression that will give you this number:
1. Move your mouse to the bottom of the Report Footer section. When the pointer becomes a double arrow with a bar, drag it to the 1-inch mark on the vertical ruler.
   You could have also right-clicked the Report Footer bar, chosen Properties, and set the Height property on the Format tab at 1”.

2. In the toolbox, click the Text Box tool (see Figure 10.7).

3. Drag the pointer to the Report Footer section and position the crosshairs 1 inch from the left and 0.5 inch from the top. Click your mouse.

4. Select the label, the box on the left. Move your pointer to the middle selector handle on the right border (see Figure 10.8). When the pointer becomes a double arrow, drag it to the .75-inch mark on the horizontal ruler.

![Figure 10.8 The selected label, with sizing handle and double arrow.]

5. Click inside the label. Delete the existing text. Type **Total Area** and press Enter. Click the Bold button on the Formatting toolbar.

6. Select the text box and click inside it. Enter an expression as follows:
   a. Type `=` to tell Access you want an expression.
   b. Type `Sum`, the function that calculates a total.
   c. Type `([Area])`, the field enclosed in brackets and parentheses.
   d. The entire expression is `=Sum([Area])`. Press Enter.

7. Press F4 to open the property sheet for the text box. On the Format tab, edit the Format property to **Standard** and **Decimal Places** to 0.

8. Close the property sheet. Click View to switch to Print Preview, and click the Last Page button (refer to Figure 10.4 to refresh your memory of its location). The total area is displayed at the bottom of the page.
When you know how to create a control for the total area, it’s simple to add one for the population:

1. Click View to return to Design view. The total area control should still be selected.
2. Choose Edit, Duplicate. A copy of the text box and label appears directly below the existing controls.
3. Move your pointer toward the text box. When the pointer becomes an open hand, drag the duplicate text box 0.5 inch from the top and 4 inches from the left.
   If you don’t know how to move controls, the section “Manipulating Controls” in Chapter 12, “Forms/Report Design Elements,” will help you.
4. Select the label. Click inside it, highlight Area, and edit it to Population. Click outside the control.
5. Select the text box. Within the expression, highlight Area and edit it to Population. Click outside the control. Your report footer should look like Figure 10.9.

![Figure 10.9 Controls for summing population and area in the Design view of the report.](image)

6. Choose File, Save (or click the Save button).
   It’s a good idea to save your report periodically if you’ve done significant work on it.
7. Click View, click the Last Page button, and scroll to the bottom of the page. The Total Population control has been added.

**Sorting and Grouping**

Thus far, you might have found creating a report tedious, but you probably haven’t found it difficult. To quickly review, you’ve used:
The Detail section, the body of the report, to display your records.

- The Page Footer to print a page number. You could have as easily used the Page Header, which prints the page number at the top of each page.
- The Report Header, which prints once at the top of the report, for the title.
- The Report Footer, which prints once at the end of the report, for aggregate totals.

With the introduction of grouping, you might find that things become a little more difficult. The concept itself is not hard to get, but the nuts and bolts of making grouping work can be confusing. I first want to make sure you understand grouping; then I go step by step through the process of implementing it.

**Political Magazine Database**

Before adding grouping to the National Governments report, it will be easier to see how it works in a database with just a few records. I use the PoliticalMagazines.mdb database, which is available from the usual webpage. You do not need to open it to review this section, but it’s there if you need it.

The Political Magazines table (see Figure 10.10) has data about several small, imaginary journals of opinion. The Politics field shows its political slant: whether it is more likely to be read by wooly-headed internationalists (left) or warmongering unilateralists (right). The Location field shows where the editorial staff is headquartered; the estimated circulation is self-explanatory.

<table>
<thead>
<tr>
<th>PoliticalMagazines : Table</th>
<th>Name</th>
<th>Politics</th>
<th>Location</th>
<th>Circulation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Happenings</td>
<td>Right</td>
<td>Washington</td>
<td>65,000</td>
<td></td>
</tr>
<tr>
<td>Metne Reader</td>
<td>Left</td>
<td>Minneapolis</td>
<td>225,000</td>
<td></td>
</tr>
<tr>
<td>National Appraisal</td>
<td>Right</td>
<td>New York</td>
<td>158,000</td>
<td></td>
</tr>
<tr>
<td>The Country</td>
<td>Left</td>
<td>New York</td>
<td>159,000</td>
<td></td>
</tr>
<tr>
<td>The New Democracy</td>
<td>Left</td>
<td>Washington</td>
<td>61,000</td>
<td></td>
</tr>
<tr>
<td>The Weekly Criteron</td>
<td>Right</td>
<td>Washington</td>
<td>55,000</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 10.10** Table of political magazine data.
The records are currently sorted in the datasheet by name. In Figure 10.11, these same records are displayed in a report where they are grouped by their political bent and, within the group, sorted by name. Both the group and the sort are in ascending order (they’re alphabetized): Left precedes right, and within the left group, Metne Reader precedes The Country.

<table>
<thead>
<tr>
<th>Left</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Metne Reader</td>
<td>Minneapolis</td>
<td>225,000</td>
</tr>
<tr>
<td>The Country</td>
<td>New York</td>
<td>159,000</td>
</tr>
<tr>
<td>The New Democracy</td>
<td>Washington</td>
<td>61,000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Right</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Human Happenings</td>
<td>Washington</td>
<td>65,000</td>
</tr>
<tr>
<td>National Appraisal</td>
<td>New York</td>
<td>159,000</td>
</tr>
<tr>
<td>The Weekly Criterion</td>
<td>Washington</td>
<td>55,000</td>
</tr>
</tbody>
</table>

Figure 10.11 Magazine data grouped by political tendency.

As you can see, grouping eliminates the need to repeat the values of Left and Right for each record. As readers, you can quickly organize and distinguish the magazines that are on the left from those on the right.

Another powerful advantage of grouping is that, just as you created summary statistics for the entire report, you can add summary statistics for each group. Figure 10.12 shows the same report with the average circulation for each group. (I used the Report Wizard to make it look a bit more professional.)
Now let’s create a group in the rptAdministration report. Despite its name, thus far the primacy of government-type data is not obvious in the report. Just as you grouped records by political tendency in the Political Magazines table, you can group records in the report to spotlight the country’s form of government.

You create groups in the report’s Sorting and Grouping dialog box. First, let’s change the current sort of CountryID (the sort in the original query) to government type:

1. Choose View, Sorting and Grouping.
   You can also click the Sorting and Grouping icon, which is shown in Figure 10.13.
2. In the Field/Expression column, open the drop-down list and choose GovtType.
3. In the Sort Order column, keep Ascending to sort alphabetically.

Figure 10.12 Grouped magazine data with aggregate totals.

Sorting and Grouping Dialog Box
Now let’s create a group in the rptAdministration report. Despite its name, thus far the primacy of government-type data is not obvious in the report. Just as you grouped records by political tendency in the Political Magazines table, you can group records in the report to spotlight the country’s form of government.

You create groups in the report’s Sorting and Grouping dialog box. First, let’s change the current sort of CountryID (the sort in the original query) to government type:

1. Choose View, Sorting and Grouping.
   You can also click the Sorting and Grouping icon, which is shown in Figure 10.13.
2. In the Field/Expression column, open the drop-down list and choose GovtType.
3. In the Sort Order column, keep Ascending to sort alphabetically.
4. Close the dialog box. Click View and scroll through your records. The records are now sorted in ascending order (alphabetically) by government type: communist, constitutional monarchy, dictatorship, and so on.

Now you’ll create the group:
5. Click View to return to Design view. Click View, Sorting and Grouping. Click in the first row.
6. In the Group Properties section, edit **Group Header** to Yes and press Enter.

The Sorting and Grouping Indicator now displays the grouping symbol in the first row, next to GovtType. You can see that a GovtType header has been created above the Detail section.
7. Edit **Group Footer** to Yes and press Enter (see Figure 10.13).

The GovtType footer is now below the Detail section.
8. Close the dialog box. Choose File, Save to save your changes.

---

**Figure 10.13** The Administration report in Design view. The GovtType field has been edited in the Sorting and Grouping window so that there is now a GovtType header and GovtType footer.
Click View and scroll through the first few pages of the report. Hmm, what's going on? The grouped report seems to be the same as the report without grouping, except that there's a little more empty space in it. Where are the group titles for each government type, such as those you saw for the Left and Right groups in Figure 10.11? Where are the aggregate statistics, such as Sum, for each group, as you saw in Figure 10.12?

Click View to return to Design view and scroll down the page. Take another look at the group sections. Yes, there is a GovtType header (a group header) above the Detail section, and, yes, there is a GovtType footer (a group footer) below it. But they're empty—there aren't any controls in them.

Here's the nasty little secret about creating groups in the Sorting and Grouping dialog box. It's like building an aquarium. When you create the group in the Sorting and Grouping dialog box, all you've done is buy a tank. You have got to put water, fish, and a plastic gazebo or two into it to make it into an aquarium. Ignoring the fishy metaphors, you must create the controls—labels, text boxes—to make the groups meaningful and informative.

**Group Header**

Fortunately, adding the controls is not hard. Because you now have a government type group, you don't need the GovtType field in the Detail section. You want to identify each group by government type, so you can use the same field in the group header section. Here are the steps:

---

**Q&A**

**Q:** Okay, I can see that I somehow created a group in the dialog box. But I still can't figure out exactly which step did that. How can changing a property of some Access element create the element itself?

**A:** Your instincts are correct: You usually create, say, a field or control first and then assign properties to it. Grouping is different. When you select a field in the Field/Expression column, the mere act of editing either its Group Header or its Group Footer property to Yes changes the sort to a group and produces sections for that group in Design view of the report.
1. In the Detail section, select the Government Type label and delete it.
2. Right-click the GovtType Header bar and select Properties. On the Format tab, edit the Height to 0.4″.
3. Select the GovtType text box. Drag it to the GovtType Header section and drop it 0.5 inch from the left and two rows of dots from the top.

Are you having trouble moving the text box into the Header section? When you move the pointer to the top of the text box, make sure it changes to an open hand, not the pointing finger. If you still have trouble, here’s an alternative method: Cut the text box, select the group section header bar, paste it, and then position it within the section.

1. On the Format tab of the Text Box: GovtType property sheet, edit the Width to 2″, the Height to 0.2″, and the Font Size to 12. Close the property sheet.
2. In the Detail section, select all four text boxes. Choose Format, Vertical Spacing, Make Equal.
3. Right-click the Detail section bar, select Properties, and edit the Height of the Detail section to 2″ (see Figure 10.14). Close the property sheet.

Figure 10.14 The Group Header and Detail sections in Design view.
Group Footer

A great advantage of grouping is including summary statistics for each group. These are usually created in the Group Footer.

You've already included summary statistics for the area and population fields in the Report Footer. A little cutting and pasting and some editing will give you the same aggregates for these fields by group:

1. Move your pointer to the 0.5-inch mark of the vertical ruler in the Report Footer section. When the pointer becomes a right arrow, click to select all four controls (see Figure 10.15).

2. Right-click any of the selected controls for a shortcut menu and choose Copy.
   You can use any Copy method—choose Edit, Copy; click the Copy button; or press Ctrl+C.
3. Right-click the GovtType Footer and click Paste.
4. Click anywhere outside any control so that no control or element is selected.
5. Right-click the Total Area label and choose Properties. On the Format tab, edit the Caption to Group Area.

Q&A

Q: These exercises are tiresome and tedious. Do you really think it’s worth my time to go through all these steps for a report I will never want to create?

A: It’s true that you’re unlikely to have this exact set of controls and circumstances. But what you are doing here—changing fonts, resizing labels, moving text boxes—involves typical tasks for editing reports. You’ll be able to build on this knowledge base for the design challenges you face.
6. Click the Total Population label to select it. On the Format tab of the property sheet, edit the Caption to Group Population. Close the property sheet.

7. Choose File, Save to save your changes. Click View to see the report.

One thing immediately strikes the eye: Within each group (such as Communist), the country names are not alphabetized. Let's alphabetize them.

1. Click View to return to Design view.
2. Choose View, Sorting and Grouping.
3. Click in the first empty row of the Field/Expression column. Open the drop-down list and choose Country. In the Sort Order column, leave Ascending as is. Close the dialog box.
4. Click View to see the report (see Figure 10.16).

![Figure 10.16](image.png)

**National Governments**

<table>
<thead>
<tr>
<th>Country</th>
<th>China</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>9,598,960</td>
</tr>
<tr>
<td>Population</td>
<td>1,259,815,458</td>
</tr>
<tr>
<td>Historical Rule</td>
<td>Independent</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Laos</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>236,800</td>
</tr>
<tr>
<td>Population</td>
<td>5,921,545</td>
</tr>
<tr>
<td>Historical Rule</td>
<td>French</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Country</th>
<th>Vietnam</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>320,560</td>
</tr>
</tbody>
</table>
Now let's take a closer look at the report. At the end of the group, there are now group totals for area and population. The same expressions that calculated total area and population for all of Asia when they were used in the report footer section now calculate the group totals when used in the group footer section.

As for the rest of report, it's adequate, but it could be better. Forcing new pages before each group would give you an improved layout. You can also have the group's name appear again at the top of the next page when the group's records span more than one page.

You'll do those tasks in the case study at the end of the chapter.

Close the report and save your changes.

You can open the completed rptAdministration in AsiaChap10End.mdb and compare your own work with it.

Creating a Report Using the Report Wizard

Whew! If you've built all of rptAdministration from scratch, you can see why even Access pros like to use the Report Wizard, at least to get a running headstart. The wizard can create the same report (or one very similar to it) that took much work by hand, with just a few clicks of the mouse. But because our purpose is pedagogical, we'll go slowly through it and take a few detours so you can understand how the wizard works and what it offers.

Collecting Data

Because the Report Wizard works so seamlessly, it's difficult to see that you're accomplishing essentially two different tasks. First, you create a query; second, using the query as a record source, you build a report.

So let's begin to unveil the wizard's workings by taking a look at the Simple Query Wizard. This tool can be used to create single-table or multitable queries. I haven't talked about it much because it's a training-wheels tool that doesn't train you, and it won't save you much time in query making. But it's useful for understanding what the Report Wizard is up to.

In the Asia database, click the Queries button in the Database window. Double-click Create Query By Using Wizard. Open the Tables/Queries drop-down list. In this dialog box, you can choose fields from any tables or query to include in your query. Click Cancel.

Click the Reports button in the Database window, and double-click Create Report By Using the Wizard. Hmm, look familiar?
The point is that, however you create a report, you start by gathering data. Usually, that means creating a query. If you don’t currently have a query for your report, you can use the wizard to assemble your data from different tables.

**Assemble Your Data**

You want a report with the same information as the one you built from scratch, so you could just select the query you created earlier in the chapter. But let’s start from scratch and get the data you need from the various tables.

1. With the first dialog box of the Report Wizard open, open the Tables/Queries drop-down list and select tblCountries.
2. Select the *Country* field and click > to add it to the selected fields. Do the same for *Area* and *Population*.
3. Open the Tables/Queries drop-down list and choose tblGovernment. Add *GovType* to the Selected Fields pane.
4. Open the Tables/Queries drop-down list and choose tblHistory. Add the *HistRule* field to Selected Fields.
5. Click Next to go to the next dialog box.

**Create the Groups**

In this dialog box, Access selects a group for you, depending on the relationships in the underlying tables. Because you can customize groups the way you want them in the next dialog box, you can ignore this dialog box and click Next.

The main group you want is government type. Select *GovtType* in the available fields and click >. A hierarchy is set up with *GovtType* at the top level and all other fields at a second level.

**Nesting Groups**

In the report you created in Design view, there was just one grouping level: government type. But you can also nest groups—you can have groups within groups within groups. Why would you want to do that?
Let’s say you work for an international consumer company, and you’re creating a sales report for the vice president of sales. He wants to see a breakdown of sales by country, and within each country by region, and within each region by sales rep.

In this case, you would create three groups. The top level would be country data. Nested within the country group would be regional data. And nested within the region would be sales rep data.

**TIP** You’ll want to limit the number of groups in your report, especially for readers who are unfamiliar with the data. Reports that have groups within groups ad infinitum can be confusing and can leave readers baffled about the overall flow of the report. The vice president of sales, however, is not likely to have problems understanding a breakdown with three or even more groups.

You can nest groups within the Asia database as well. Suppose that within each government group you want to add another level for the historical rule. In that case, you’d have the first group—say, Communist—and within the group, there would be additional groups for each historical rule (British, French, and so on). Then you’d have the second group, Constitutional Monarchy, and within this group, there would again be groups for each historical rule. (I included in your solution database AsiaChap10End.mdb an example of such a report. Its title is rptAdministrationTwoGroups, and you can view it at your leisure.)

1. At the left of the dialog box, select HistRule and click the right arrow.
   The report is now grouped first by government type and then by historical rule (see Figure 10.17). The HistRule group is selected in the scheme.
2. In the dialog box, click the up arrow above Priority. Now your report is grouped first by historical rule and then by government type.

3. With HistRule selected, click < so your report is grouped only by government type.

4. Click Next to go to the next dialog box.

**Sort the Records**

Within each group, you can choose additional field sorts. Within each government type group, let's sort the records by country. Open the drop-down list and select Country. Use an ascending sort to keep them alphabetized. (You can change the sort to descending by merely clicking Ascending.)

**Q&A**

**Q:** Why would I possibly want to add as many as four sorts?

**A:** Again, let's assume that it's a sales report for an international company. Assume that you have just one group, country. Even though you've...
decided that you have no particular need for summary statistics for sub-
groups, you still would like to sort the records by several fields so you can
easily locate the detail records. Within each country you would sort
records by region, within each region by city, within each city…well, you
get the idea.

Summary Options

The wizard can add aggregate totals for you, for both the group and the
entire report.

1. In the current dialog box, click Summary Options.
2. Click the Area and Population boxes under Sum to select them.
   This gives you sums for these fields for each government group, as
   well as grand totals for each at the end of the report. Because you
   want to see both records and totals, the Detail and Summary
   option should be selected.
3. Click OK and click Next to go to the next dialog box.

Layout

The dialog box for choosing a layout isn’t terribly helpful, to say the least.
Both the names and the graphical schemes are imprecise, and some are
more confusing than anything else. If reports are central to your work,
you’ll want to try a few different layouts and see how they look. You might
want to create a few reports using different schemes to see what they actu-
ally look like.

1. In the Layout section, select Align Left 1. In Orientation, Portrait
   should be selected.
   Many reports use landscape orientation, which turns the printed
   page sideways so you can fit more fields on each page, but fewer
   records. You designed the earlier report using a portrait orienta-
tion, so to make the comparison equal, use Portrait (it shouldn’t
make much of a difference with relatively few fields). Note that,
within the report itself, you can choose the orientation by selecting
File, Page Setup, Page tab.
2. Select Adjust the Field Width so all fields fit on a page. This choice can be catastrophic when you have many (say, 8 or 10) fields scrunched into one page, but you have relatively few here, so you should be okay.

3. Click Next to go to the next dialog box.

**Style and Title**

The style choice is your own. Only Casual is unsuitable for business purposes (and even that's questionable).

1. Select Corporate and click Next to go to the next dialog box.

2. Give your report the title `rptAdministrationWizard` and click Finish. Access builds your report (see Figure 10.18).

You can compare your report with the completed `rptAdministrationWizard` in your solution database `AsiaChap10End.mdb`.

---

**rptAdministrationWizard**

<table>
<thead>
<tr>
<th>GovtType</th>
<th>Communist</th>
<th></th>
<th>Population</th>
<th>Historical Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>Area</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>9,590,000</td>
<td>1,208,975,465</td>
<td>Independent</td>
<td></td>
</tr>
<tr>
<td>Laos</td>
<td>236,000</td>
<td>5,921,646</td>
<td>French</td>
<td></td>
</tr>
<tr>
<td>Vietnam</td>
<td>320,580</td>
<td>81,624,716</td>
<td>French</td>
<td></td>
</tr>
</tbody>
</table>

Summary for `GovtType` = `Communist` (3 total records)

<table>
<thead>
<tr>
<th>Sum</th>
<th></th>
<th>Population</th>
<th>Historical Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>16,193,320</td>
<td>1,574,621,729</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GovtType</th>
<th>Constitutional Monarchy</th>
<th></th>
<th>Population</th>
<th>Historical Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>Area</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bahrain</td>
<td>655</td>
<td>867,235</td>
<td>British</td>
<td></td>
</tr>
<tr>
<td>Brunei</td>
<td>5,770</td>
<td>358,058</td>
<td>Multiple Rulers</td>
<td></td>
</tr>
<tr>
<td>Cambodia</td>
<td>181,040</td>
<td>13,124,784</td>
<td>French</td>
<td></td>
</tr>
<tr>
<td>Japan</td>
<td>372,635</td>
<td>127,214,499</td>
<td>Independent</td>
<td></td>
</tr>
<tr>
<td>Jordan</td>
<td>1,635</td>
<td>5,460,985</td>
<td>British</td>
<td></td>
</tr>
<tr>
<td>Kuwait</td>
<td>17,520</td>
<td>2,163,181</td>
<td>British</td>
<td></td>
</tr>
<tr>
<td>Malaysia</td>
<td>320,750</td>
<td>25,092,043</td>
<td>British</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 10.18** The report created from the wizard.
Comparing the From-Scratch and From-Wizard Reports

Let’s compare the report you created from scratch (refer to Figure 10.16) with the report you made with the wizard (refer to Figure 10.18). If you view the two reports in Print Preview, you’ll see that the data presented is the same. But there are obvious differences in the design.

It’s a good idea to open both reports and tile them, as well as switch freely between Design view and Print Preview in each to see how the controls determine the display. Both reports are in your solution database AsiaChap10End.mdb.

This similarities and differences between the reports include the following:

- **Report header**—Both reports use labels to title the reports. You can easily edit the title in the wizard report by editing the label’s Caption property on the Format tab.
- **Page header**—Both page headers are empty and contain no controls.
- **GovtType header and Detail**—The from-scratch report has a single control, a text box whose source is the government type field. It tells the name of each group (Communist, constitutional monarchy, and so on). The wizard report includes both a label (GovtType) and a text box that names the group. You could easily delete the label and move the text box left for a less cluttered look. The wizard report also has labels in the GovtType header for the country, area, population, and historical rule fields. The text boxes for these fields are in the Design section. In contrast, the from-scratch report uses a columnar format that has both the field labels and text boxes in the Detail section. The tabular format of the wizard report reduces the number of required pages by two-thirds. With a little work, you could move around the labels and text boxes in the from-scratch report to achieve the same tabular layout.
- **GovtType footer**—The from-scratch report has label/text box pairs for group area and population totals. In the wizard report, the tabular format requires only text boxes with expressions for these sums. (You might need to widen these just a tad to see the full total for all groups.) Although there are no field labels in the wizard report, there is a label of Sum on the far left for clarity.
The wizard report also includes a very long expression that tells you the number of records in the group. You might or might not find this information useful.

■ **Page footer**—The from-scratch report has a text box that tells you the page number. The wizard report has the same, although the expression is a little more complex because it's in the “Page N of M” format.

The wizard report also contains a control on the left with the expression `Now`, which tells you the current date.

■ **Report footer**—As with the group totals, in the from-scratch report, there are area and population labels for the grand totals. The tabular format of the wizard dispenses with these labels, but it does include a label at the far left for **Grand Total**. In the wizard report, you might need to widen the text boxes just a bit to see the full totals.

### Conclusion

In this chapter, you built reports both from scratch and using the wizard. Along the way, you learned about sorting and (especially) grouping, concatenation, calculated expressions, and various report tools. If you had trouble with some of the basics, such as moving and resizing controls, you’ll find some help in Chapter 12, which discusses these topics in some detail.

### Case Example

As this chapter has demonstrated, report creation involves many techniques and methods. This case example exposes you to a few more by making some improvements to `rptAdministration`.

In the Database window, open `rptAdministration` in Design view.

Choose File, Save As and save the report as `rptAdministrationCS`.
**Cover Pages**

Report headers are commonly used to create cover pages, which tell readers what’s in the report, who originated the information, who created the report, the date of the report, and so forth.

The current title of **National Governments** really doesn’t do justice to the material within and certainly could stand some explanation. We could dump it entirely, but let’s just add a subtitle below it, along with pertinent data about the report:

1. Select the **National Governments** label and click after the letter s.
2. Press Shift+Enter to move to the next line.
3. Type **Key Political Data** and press Shift+Enter.
4. Type **CIA World Factbook**. Press Shift+Enter.
5. Type **John Doe**. Press Shift+Enter.
6. Type **January 1, 200X**. Press Enter.
8. Click View to see the report.

The title itself looks okay, but the data starts right after the last line of the title on the same page. Let’s put things right.

**NOTE** Because the **CIA World Factbook** is in the public domain, the data is not copyrighted. Depending on the report and audience, you might need to include copyright notices in your report.

9. Click View to return to Design view. Right-click the Report Header bar and choose Properties.
10. On the Format tab, edit the **Force New Page** property to **After Section**. This leaves the title by itself on the cover page.
11. Edit the **Height** property to 6”.
12. Select the label in the header. Edit **Top** to 4”. Close the property sheet. Figure 10.19 shows the label at the bottom of the report header section.
Click View to see the report.

Much better—now the only extraneous item remaining on the page is the page number at the bottom. You could edit the expression in the control in the page footer so that no page number would print on page 1. But it’s a lot easier to simply delete the control and create a new one using the Page Number dialog box.

Click View to return to Design view.

In Page Footer, select the page number control and press delete.

Choose Insert, Page Numbers.

In the Page Number dialog box, select a format of Page N of M, a position of Bottom of Page, and an alignment of Right. Deselect Show Number on First Page. Click OK.

Click View to see that there is no page number on the first page.

Separating Groups

If you don’t mind lengthening your report somewhat, you can put the data for each group on separate pages. You use the same Force New Page property, except that the pertinent property sheet is that for the group header.

Click View to return to design view.

Right-click the GovtType Header bar and choose Properties.

Edit the Force New Page property to Before Section.

Click View to see the report. Review the Constitutional Monarchy group.
The Constitutional Monarchy section extends over a few pages, beginning on or about page 3. But there is only a group title on the first page, not on succeeding pages. You can have the group’s name appear again at the top of succeeding pages when the group’s records span more than one page.

5. Click View to return to Design view. The GovtType Header property sheet should still be open.
6. On the Format tab, edit Repeat Section to Yes.
7. Click View and scroll through your finished report (see Figure 10.20).

Figure 10.20 This is third and last page that has data about the group Constitutional Monarchy. The next group, Dictatorship, doesn’t start until the following page.

8. You can compare your report with rptAdministrationCS in AsiaChap10.mdb. When you’re done, save your work. Close the report and the database.